Configuraciéon de VPN de acceso remoto
AnyConnect en FTD
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Introduccioén

Este documento describe una configuracién para AnyConnect Remote Access VPN en FTD.

Prerequisites

Requirements
Cisco recomienda que tenga conocimiento sobre estos temas:
. Conocimiento basico de VPN, TLS e IKEv2

- Conocimiento basico de autenticacion, autorizacion y contabilidad (AAA) y RADIUS
- Experiencia con Firepower Management Center

Componentes Utilizados

La informacion que contiene este documento se basa en las siguientes versiones de software y
hardware.

. FTD 7.2.0 de Cisco



- Cisco FMC 7.2.1
- AnyConnect 4.10

La informacion que contiene este documento se creo a partir de los dispositivos en un ambiente
de laboratorio especifico. Todos los dispositivos que se utilizan en este documento se pusieron en
funcionamiento con una configuracion verificada (predeterminada). Si tiene una red en vivo,
asegurese de entender el posible impacto de cualquier comando.

Antecedentes

Este documento proporciona un ejemplo de configuracion para Firepower Threat Defence (FTD)
version 7.2.0 y posteriores, que permite que la VPN de acceso remoto use Transport Layer
Security (TLS) e Internet Key Exchange version 2 (IKEv2). Como cliente, se puede utilizar Cisco
AnyConnect, que es compatible con varias plataformas.

Configuracion

1. Prerequisites
Para pasar a través del asistente de acceso remoto en Firepower Management Center:

- Cree un certificado utilizado para la autenticaciéon del servidor.

- Configure el servidor RADIUS o LDAP para la autenticacion de usuarios.
- Cree un conjunto de direcciones para los usuarios de VPN.

- Cargue imagenes de AnyConnect para diferentes plataformas.

a) Importar el certificado SSL

Los certificados son esenciales al configurar AnyConnect. El certificado debe tener una extension
de nombre alternativo de sujeto con nombre DNS o direccion IP para evitar errores en los
navegadores web.

Nota: Solo los usuarios registrados de Cisco tienen acceso a las herramientas internas y a
la informacién de errores.

Existen limitaciones para la inscripcion manual de certificados:
- En el FTD necesita el certificado de CA antes de generar el CSR.

- Si el CSR se genera externamente, el método manual falla, se debe utilizar un método diferente
(PKCS12).

Hay varios métodos para obtener un certificado en un dispositivo FTD, pero el mas seguro y facil
es crear una solicitud de firma de certificado (CSR), firmarla con una autoridad de certificacion
(CA) y luego importar el certificado emitido para una clave publica, que estaba en CSR. A
continuacion se explica como hacerlo:

- Vaya a Objects > Object Management > PKI > Cert Enrollment Haga clic en Add Cert Enroliment.



Add Cert Enroliment (7]

Name*
vpntestbbed.cisco.com
Description
|
CA Information Certificate Parameters Key Revocation

Enrollment Type: | Manual v
[ ] CA Only
Check this option if you do not require an identity certificate fo be created
from this CA
CA Certificate: Ep':“_ Iangreno .. ST2xar
YfPCilB7g

BMAV7Gzdc4VspS6ljirAhbiiaw
dBiQIQmsBeFz9JkF4..b3I8Bo
GN+gMa56Y
lt8unaZgY4l20//on88r5IWJIm

Validation Usage: IPsec Client SSL Client [ | SSL Server
| | Skip Check for CA flag in basic constraints of the CA Certificate

|| Allow Overrides

| Cancel | Save

- Seleccionar Enroliment Type Y pegue el certificado de la autoridad certificadora (CA) (el
certificado que se utiliza para firmar la CSR).

- A continuacién, vaya a la segunda pestafa y seleccione custom FQDN Y rellene todos los
campos necesarios, por ejemplo:



Add Cert Enroliment Q

Name*
vpntesthbed.cisco.com
Description
CA Information Certificate Parameters Key Revocation

Include FQDN: Use Device Hostname as FODN

Include Device's IP Address: 10.88.243.123

Common Mame (CN): vpntestbed.cisco.com

Organization Unit (OU): TAC

Organization (0): | Mexico

Locality (L): | MX

State (ST): CDMX

Country Code (C): | MX

Email (E): I tac@cisco.com

Include Device's Serial Number | |

|| Allow Overrides

Cancel Save

- En la tercera ficha, seleccione key Type, €lija nombre y tamafo. Para RSA, 2048 bits es
minimo.

- Haga clic en Guardar y vaya a Devices > Certificates > Add > New Certificate.

- A continuacion seleccione Device, y €n Cert Enroliment Seleccione el punto de confianza que
acaba de crear y haga clic en Add:



Add New Certificate (7]

Add a new certificate to the device using cert enrollment object which is used to
generate CA and identify certificate.

Device®:
FTD v

Cert Enrollment®:

l vpntestbed.cisco.com| v ‘ +

Cert Enrollment Details:

MName: vpntestbed.cisco.com

- Mas adelante, junto al nombre del punto de confianza, haga clic en el botén 'l:::'? icono, a
continuacion vesy, a continuacion, copie CSR en CA y firmela. El certificado debe tener los
mismos atributos que un servidor HTTPS normal.

- Después de recibir el certificado de CA en formato base64, seleccionelo en el disco y haga
clic en import. Cuando esto tenga éxito, vera:

=D -

vntesshed.ctsen.com Gicoal Seit-Signed oA (4D tRPCE

b) Configuracién del servidor RADIUS

. Vaya a Objects > Object Management > RADIUS Server Group > Add RADIUS Server Group.
- Rellene el nombre y agregue la direccion IP junto con el secreto compartido. Haga clic en

Save:



Edit RADIUS Server

IP Address/Hostname:*

192.168.20.7
Configure DNS at Threat Defense Platform Settings to resolve hostname
Authentication Port:* (1-65535)

1812
Key:*

Confirm Key:*

—
—a
I
an
(9 |
(]
Cad
(9 |

Accounting Port:
1813

Timeout: (1-300) Seconds
10

Connect using:
(® Routing () Specific Interface @

Default: Management/Diagnostic k

Redirect ACL:

| Cancel | Save

- Después de esto, vera el servidor en la lista:

Marme Value

RadiusServer 1 Server

¢) Crear un conjunto de direcciones para usuarios de VPN



. Vaya a Objects > Object Management > Address Pools > Add IPv4 Pools.
- Pon el nombre y el rango, la mascara no es necesaria:

Name*

I vpn_pool ‘

IPv4 Address Range*
\ 10.72.1.1-10.72.1.150 \

Mask
‘ Specify a netmask in X.X.X.X format ‘

Description

Allow Overrides

. Configure device overrides in the address pool object to
avoid IP address conflicts in case of object is shared across
multiple devices

»  Override (0)

d) Crear perfil XML

- Descargue el Editor de perfiles del sitio de Cisco y abralo.
- Vaya a Server List > Add...
- Colocar nombre para mostrar y FQDN. Vera entradas en la Lista de servidores:

[ AnyConnect Profile Editor - VPN — O *
File Help
4 -
VPN | Server List
@ Preferences (Part 1)

Profile: C:AUsers\calo\Documents\Anyconnect_profile.xml

----- -+ Preferences (Part 2)
----- Backup Servers

----- % Certificate Pinning
=0 Certificate Matching
----- Certificate Enrollment

Hostname Host Address User Group Backup Server List  SCEP Maobile Settings Certificate Pins

VPM(S5L) vpntestbed.dsco.... - Inherited —
[} Mobile Policy VPN(IPSEC) vpntestbed. dsco.... - Inherited -

----- Server List

Mote: it is highly recommended that at least one server be defined in a profile. Add... ' Delete

- Haga clic en oKy File > Save as...



e) Cargar imagenes de AnyConnect

- Descargue imagenes de paquetes del sitio de Cisco.
. Vaya a Objects > Object Management > VPN > AnyConnect File > Add AnyConnect File.
- Escriba el nombre y seleccione el archivo PKG del disco; haga clic en save:

Edit AnyConnect File (7]

Mame:*

| Wnyconnectmac4.10 |

File Name:*

| anyconnect-macos-4.10.06079-webdef | | Browse..
File Type:*

| AnyConnect Client Image v |
Description:

Cancel |

- Agregue mas paquetes en funcion de sus propios requisitos.

2. Asistente para acceso remoto

- Vaya a Devices > VPN > Remote Access > Add a new configuration.
- Asigne un nombre al perfil y seleccione el dispositivo FTD:



Targeted Devices and Protocols

This wizard will guide you through the required minimal steps to configure the Remote
Access VPN policy with a new user-defined connection profile.

Mame:*

| Anyconnect_RA |

Description:

VPN Protocols:

SSL
IPsec-IKEv2

Targeted Devices:

Available Devices Selected Devices

| Q_ Search | FTD

FTD

- En el paso Perfil de conexion, escriba Connection Profile Name, seleccione la Authentication Server y
Address Pools que cred anteriormente:



Connection Profile:

Connection Profiles specify the tunnel group policies for a VPN connection. These policies pertain to creating the
tunnel itself, how AAA is accomplished and how addresses are assigned. They also include user attributes, which
are defined in group policies.

Connection Profile Name:* | Anyconnect_RA

I @ This name is configured as a connection alias, it can be used to connect to the VPN gateway

Authentication, Authorization & Accounting (AAA):

Specify the method of authentication (AAA, certificates or both), and the AAA servers that will be used for VPN
connections.

Authentication Method: [ AAA Only v l

RadiusServer v l -+
(LOCAL or Realm or RADIUS)
[ Fallback to LOCAL Authentication

Authentication Server:*

Authorization Server: | Use same authentication server | +
(Realm or RADIUS)

Accounting Server: | v | -
(RADIUS)

Client Address Assignment:

Client IP address can be assigned from AAA server, DHCP server and IP address pools. When multiple options are
selected, IP address assignment is tried in the order of AAA server, DHCP server and IP address pool.

] Use AAA Server (Realm or RADIUS only) @
[ ] Use DHCP Servers
Use IP Address Pools

IPvd Address Pools: | vpn_pool

N

IPv6 Address Pools: I

Group Policy:

A group policy is a collection of user-oriented session attributes which are assigned to client when a VPN
connection is established. Select or create a Group Policy object.

Group Policy:* DfitGrpPolicy v | +

Edit Group Policy

- Haga clic en Edit Group Policy Y en la ficha AnyConnect, seleccione client Profile, haga clic en save:



Edit Group Policy (7]

Name:*
DfitGrpPolicy

Description:

General AnyConnect Advanced

Profile

AnyConnect profiles contains settings for the VPN client functionality and
Management Profile = optional features. Firewall Threat Defense deploys the profiles during

AnyConnect client connection.
Client Modules

SSL Settings Client Profile:
Anyconnect_profile A | +

Connection Settings

Custom Attributes Standalone profile editor can be used to create a new or modify existing
AnyConnect profile. You can download the profile editor from Cisco Software
Download Center.

- En la pagina siguiente, seleccione imagenes de AnyConnect y haga clic en Next.
AnyConnect Client Image

The VPN gateway can automatically download the latest AnyConnect package to the client device when the VPN
connection is initiated. Minimize connection setup time by choosing the appropriate OS for the selected package.

Download AnyConnect Client packages from Cisco Software Download Center.

Show Re-order buttons 4

AnyConnect File Object Name AnyConnect Client Package Name Operating System

Anyconnectmac4.10 anyconnect-macos-4.10.06079-webdeploy... Mac OS v ‘

- En la siguiente pantalla, seleccione Network Interface and Device Certificates:



Network Interface for Incoming VPN Access

Select or create an Interface Group or a Security Zone that contains the network interfaces users
will access for VPN connections.

Interface group/Security Zone:* | Outsied v | +

Enable DTLS on member interfaces

A All the devices must have interfaces as part of the Interface Group/Security Zone selected.

Device Certificates

Device certificate (also called Identity certificate) identifies the VPN gateway to the remote access
clients. Select a certificate which is used to authenticate the VPN gateway.

Certificate Enrollment:* vpntestbed.cisco.com v | +

Access Control for VPN Traffic

All decrypted traffic in the VPN tunnel is subjected to the Access Control Policy by default. Select
this option to bypass decrypted traffic from the Access Control Policy.

Bypass Access Control policy for decrypted traffic (sysopt permit-vpn)
This option bypasses the Access Control Policy inspection, but VPN filter ACL and
authorization ACL downloaded from AAA server are still applied to VPN traffic.

- Cuando todo esté configurado correctamente, puede hacer clic en Finish y luego Deploy:



o o - (] L
r o el o EE, T
Remote Outside VPN

AnyConnect
User Client Device
5
ABA

Remete Access VN Policy Configurstion Additional Configuration Requirements

Firepower Management Center will configure an RA VPN Policy with the following settings After the wizard completes, the following

Name: Anyconnect_RA configuration needs to be completed for VPN to
Device Targets: FTD work on all device targets.
Connection Profile: Anyconnect_RA ®)AGcess Contml Bl lpdats
Connection Alias: Anyconnect_RA
AAA: An Access Control rule must be defined to allow
g VPN traffic on all targeted devices.
Authentication Method:  AAA Only ) )
Authentication Server: RadiusServer (RADIUS) & NAT Exemption
Authorization Server: RadiusServer (RADIUS) If NAT is enabled on the targeted devices, you
Accounting Server: - must define a NAT Policy to exempt VPN traffic.
Address Assignment: © DNS Configuration
Address from AAA: - To resolve hostname specified in AAA Servers
DHCP Servers: - or CA Servers, configure DNS using FlexConfig
Address Pools (IPvd): vpn_poal Policy on the targeted devices.
Address Pools (IPv6): - © Port Configuration
Group Policy: DftarpPolloy SSL will be enabled on port 443.
AnyConnect Images: Anyconnectmac4.10 IPsec-IKEv2 uses port 500 and Client Services
. ; il be enabled on port 443 for Anyconnect
Interface Objects: Outsied el :
' — . image download.NAT-Traversal will be enabled
Device Certificates: vpntestbed.cisco.com by default and will use port 4500.

Please ensure that these ports are not used in
NAT Policy or other services before deploying
the configuration.
Device Identity Certificate Enrollment
A Network Interface Configuration
Certificate enrollment object 'vpntestbed.cisco.com’ is not installed on one or more .
targeted devices. Certificate installation will be initiated on the targeted devices on Make sure to add interface from targeted
finishing the wizard. Go to the Certificates page to check the status of the installation. devices to SecurityZone object 'Outsied'

- Esto copia toda la configuracién junto con los certificados y los paquetes de AnyConnect en el
dispositivo FTD.

Conexién

Para conectarse al FTD debe abrir un explorador, escribir un nombre DNS o una direccion IP que

apunte a la interfaz externa. A continuacién, inicie sesion con las credenciales almacenadas en el

servidor RADIUS vy siga las instrucciones de la pantalla. Una vez que se instala AnyConnect, debe
poner la misma direccion en la ventana de AnyConnect y hacer clic en Connect.

Limitaciones

Actualmente no es compatible con FTD, pero esta disponible en ASA:

- La seleccion de interfaz en el servidor RADIUS no se admite en Firepower Threat
Defense6.2.3 o versiones anteriores. La opcion de interfaz se omite durante la
implementacion.

- Un servidor RADIUS con autorizacién dinamica requiere Firepower Threat Defense6.3 o
posterior para que funcione la autorizacién dinamica.



- FTDposture VPN no admite el cambio de politica de grupo a través de la autorizacion
dinamica o el cambio de autorizacion RADIUS (CoA).

- Personalizacion de AnyConnect (mejora: ID de error de Cisco CSCvq87631)

- Scripts de AnyConnect

- localizacién de AnyConnect

- Integracion de WSA

- Mapa criptografico dinamico IKEv2 simultaneo para VPN RA y L2L (Mejora: ID de error de
Cisco CSCvr52047)

- Modulos AnyConnect (NAM, Hostscan, AMP Enabler, SBL, Umbrella, Web Security, etc.):
DART se instala de forma predeterminada (Mejoras de AMP Enabler y Umbrella: ID de error
de Cisco CSCvs03562 e ID de error de Cisco CSCvs06642).

- TACACS, Kerberos (autenticacion KCD y RSA SDI)

- Proxy de explorador

Observaciones de seguridad

De forma predeterminada, el sysopt connection permit-vpnesta desactivada. Esto significa que debe
permitir el trafico que proviene del conjunto de direcciones en la interfaz externa a través de la
politica de control de acceso. Aunque la regla de prefiltro o control de acceso se agrega para
permitir solamente el trafico VPN, si el trafico de texto sin cifrar coincide con los criterios de la
regla, se permite errbneamente.

Hay dos enfoques para este problema. En primer lugar, la opcion recomendada por el TAC es
habilitar la antisimulacién (en ASA se la conocia como Unicast Reverse Path Forwarding - uRPF)
para la interfaz externa y, en segundo lugar, habilitar sysopt connection permit-vpn para omitir
completamente la inspeccion de Snort. La primera opcion permite una inspeccién normal del
trafico que va hacia y desde los usuarios de VPN.

a) Habilitar uRPF

- Cree una ruta nula para la red utilizada por los usuarios de acceso remoto, definida en la
seccion C. Vaya a Devices > Device Management > Edit > Routing > Static Route Y Seleccione Add route


https://cdetsng.cisco.com/summary/#/defect/CSCvq87631
https://cdetsng.cisco.com/summary/#/defect/CSCvr52047
https://cdetsng.cisco.com/summary/#/defect/CSCvs03562
https://cdetsng.cisco.com/summary/#/defect/CSCvs06642

Add Static Route Configuration 7

Type: @ IPvd () IPV6
Interface*
\ Nullo v \

(Interface starting with this icon [ signifies it is available for route leak)

Available Network . Selected Network

Q, Search ‘ Add ‘ objvpnusers ™
any-ipvd
FMC
GW

IPvd-Benchmark-Tests
IPvd-Link-Local
IPvd-Multicast

Gateway*

Metric:
1

(1 -254)

Tunneled: [ | (Used only for default Route)

Route Tracking:

- Luego, habilite uRPF en la interfaz donde terminan las conexiones VPN. Para encontrar esto,
navegue hasta Devices > Device Management > Edit > Interfaces > Edit > Advanced > Security Configuration >
Enable Anti Spoofing.



Edit Physical Interface

General IPwd IPv6 Path Monitoring Hardware Configuration

Information ARP Security Configuration

Enable Anti Spoofing:
Allow Full Fragment Reassembly:

Override Default Fragment Setting:

Advanced

Manager Access

‘ Cancel |m

Cuando un usuario esta conectado, la ruta de 32 bits se instala para ese usuario en la tabla de
ruteo. Borre el trafico de texto originado en las otras direcciones IP no utilizadas del conjunto que
son descartadas por uRFP. Para ver una descripcion de Anti-Spoofingconsulte Establecer
parametros de configuracién de seguridad en Firepower Threat Defence.

b) Habilitar sysopt connection permit-vpn Opcién

- Si tiene la version 6.2.3 o posterior, existe la opcion de hacerlo con el asistente o en Devices >

VPN > Remote Access > VPN Profile > Access Interfaces.

Access Control for VPN Traffic

Bypass Access Control policy for decrypted traffic (sysopt permit-vpn)

e

LA

-'ﬁ

o

f_,

¥¥
bypasses the inspection, bt

o

ALl server are still -\.-"'_-Il-\.-'“"l_l to VPN trafiic.

ted traffic is subjected to Access Control Policy by default.

! FR 5 | Fr
t VPN Filter ACL and authorization ACL downloaded from

o e
r'||' Onon

- Para las versiones anteriores a la 6.2.3, vaya a Objects > Object Management > FlexConfig > Text Object

> Add Text Object.

- Cree una variable de objeto de texto, por ejemplo: vpnSysVar una sola entrada con valor

sysopt.

. Vaya a Objects> Object Management > FlexConfig > FlexConfig Object > Add FlexConfig Object.

- Cree el Flexconfig objeto con CLI connection permit-vpn.

- Inserte la variable de objeto de texto en el FlexConfig en la CLI con $vpnSysVar connection permit-

vpn. Haga clic en save:


/content/en/us/td/docs/security/firepower/622/configuration/guide/fpmc-config-guide-v622/interfaces_for_firepower_threat_defense.html?bookSearch=true#task_34BB9AC8E91946AB847C65FB79D67A5F
/content/en/us/td/docs/security/firepower/622/configuration/guide/fpmc-config-guide-v622/interfaces_for_firepower_threat_defense.html?bookSearch=true#task_34BB9AC8E91946AB847C65FB79D67A5F

Insert Text Object Variable

Variable Name: | wpnSysvar
Description:

Available Objects & Selected Object

[ 4, Search [T vpnSysvar

S ———

[T tepMssBytes
[T tepMssMinimum
[T threat_cetection_statistics

[T vadan_wve_only

[T vdtan_Port_and_Nve
[T wtan_wni

[T weepPassword

- Aplique el FlexConfigobjeto como Append y seleccione implementacidn para Everytime:

Variables E]
vpnSysvar SINGLE sysopt FREEFORM:vpn.. false

Edit FlexConfig Object ? %
Name: | connection_permit-vpn
Description:

Oumsern~ | E | Deploymert: Type:

[ Save J [ Cancel

J

- Vaya abevices > FlexConfig y editar la directiva actual o crear una nueva con New Policy botén.
- Agregue solo los elementos creados FlexConfig, haga clic en save.
- Implementar la configuracién para aprovisionarsysopt connection permit-vpnen el dispositivo.

Después de esto, sin embargo, no puede utilizar la politica de control de acceso para
inspeccionar el trafico que proviene de los usuarios. Aun puede utilizar el filtro VPN o ACL
descargable para filtrar el trafico de usuario.

Si ve paquetes descartados con Snort de los usuarios de VPN, comuniquese con TAC y haga




referencia al Id. de bug de Cisco CSCvg91399.

Informacion Relacionada

- Asistencia técnica y descargas de Cisco



https://cdetsng.cisco.com/summary/#/defect/CSCvg91399
https://www.cisco.com/c/es_mx/support/index.html?referring_site=bodynav

Acerca de esta traduccidén

Cisco ha traducido este documento combinando la traduccién automatica y los recursos
humanos a fin de ofrecer a nuestros usuarios en todo el mundo contenido en su propio
idioma.

Tenga en cuenta que incluso la mejor traduccién automatica podria no ser tan precisa como
la proporcionada por un traductor profesional.

Cisco Systems, Inc. no asume ninguna responsabilidad por la precision de estas
traducciones y recomienda remitirse siempre al documento original escrito en inglés (insertar
vinculo URL).



